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Quality Assurance Plan 
 

1. Introduction 

1.1 Purpose 

 

The purpose of this document is to state the policy of Anais Software Services Quality Assurance 

Strategy Policies used in software development. This document addresses to all parts involved: clients, 

managers, developers, testers and other parts interested in development of a product. 

 

The responsibility of quality process is not only the attribute of QA department but of the whole resources 

including human resources, material and environmental resources. 

 

1.2 Scope 

 

This document is part of the ANAIS SOFTWARE SERVICES Guidelines and Policies Library therefore 

must be followed accordingly. Intended audience includes: 
 

1. Customer Representatives 
2. Project Managers 
3. Quality Assurance Group 
4. Developers 

 

The Quality Assurance Manager who is responsible for the integrity of the document must ensure that: 

 
1. The document is produced in a timely manner 
2. The document is kept consistent with ANAIS SP 
 

1.3 Definitions, Acronyms and Abbreviations 

 

Term Definition 

QA ‘‘all the planned and systematic activities implemented within the quality system to 
provide confidence that the project will satisfy the relevant quality standards.’’ 

AUP Anais Software Services Unified Process 

 

1.4 References 

 

IEEE Standard for Software Test Documentation; Approved 16 September 1998, IEEE-SA 
Standards Board 
 
Key Practices of the Capability Maturity ModelSM, Version 1.1; Mark C. Paulk, Charles V. 
Weber, Suzanne M. Garcia, Mary Beth Chrissis, Marilyn Bush. February 1993 
 

2. QA Overview 

 

Please notice that, a quality plan that addresses both key project processes and project deliverables must 

be in conjunction with stakeholders.  
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Please notice that “quality” is a subjective term. That is why, together with customer representatives, clear 

criteria must be established for specifically defining quality at each key checkpoint or for each deliverable.  

Roles and responsibilities for the key quality assurance evaluators must also be established with 

management representatives.  

There must be a clear agreement on the points in time that quality reviews will occur and how and to 

whom findings will be reported.  

Anais Software Services will ensure the quality by involving quality resources: 

- qualitative environment (offices and facilities that will sustain the activity  ) 

- qualitative material ressources (computers, communicative tools – phones etc) 

- qualitative technologies (software) 

- qualitative management 

- qualitative human resources – well trained professionals, with certified abilities and 
competences 

- qualitative process – see AUP (Anais Unified Process) 

- qualitative management 

3. Quality Objectives 

 

The Quality Assurance Plan describes the strategy and methods Anais Software Services will deploy to 

ensure that:  

� That the project is being managed, developed, and deployed in a sound, reasonable way.  

� That the project's deliverables are of acceptable quality before they are delivered to the project's 
clients 

� The AUP is followed 

� Standards (of implementation, coding, testing, communication, etc) agreed with stakeholders are 
followed. 

4. Capability Maturity Model - QA perspective 

4.1 Goals 

 

Goal 1 The project's software quality management activities are planned.  

Goal 2 Measurable goals for software product quality and their priorities are defined.  

Goal 3 Actual progress toward achieving the quality goals for the software products is quantified and 

managed.  

 

4.2 Commitment to perform  

Comm # Policy Examples 

Comm 1 The project's software quality management activities support 

the organization's commitment to improve the quality of the 
Improvements to the process that increase 

software product quality are a top priority of the 
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software products. organization.  

The project defines and collects the measurements used for 

software quality management based on the project's defined 

software process. 

 

The project defines the quality goals for the software 

products and monitors its progress towards them. 

 

Responsibilities for software quality management are defined 

and assigned to the software engineering group and other 

software-related groups. 

-software quality assurance,  

-software configuration management 

- documentation support.  

 

4.3 Ability to perform  

Ab # Ability Description Indicators Examples 

Specialty engineers in areas such as 

safety and reliability are available to 

help set the software quality goals and 

review progress towards the goals. 

 Ab 1 Adequate resources and 

funding are provided for 

managing the quality of 

the software products.  

Tools to support predicting, measuring, 

tracking and analyzing software quality 

are made available.  

 

-data collection tools,  

-database systems,  

-spreadsheet programs,  

-software life-cycle simulators,  

-quantitative analysis tools  

- code audit tools.  

Ab 2 The individuals 

implementing and 

supporting software 

quality management 

receive required training 

to perform their activities. 

Refer to the Training Program key 

process area.  

 

-planning quality commitments and goals for 

the product, 

-measuring product and process quality 

-controlling product quality using the defined 

software process. 

Ab 3 The members of the 

software engineering 

group and other software-

related groups receive 

required training in 

software quality 

management. 

Refer to the Training Program key 

process area.  

 

-understanding the goals and benefits of 

quantitatively managing product quality,  

-collecting measurement data,  

-understanding the quality measurements for 

the software process and product, and  

- planning and controlling the quality of the 

software product.  

4.4 Activities performed 

Act # Activity description Indicators Examples 

An understanding of the software quality 

needs of the organization, customer, 

and end users is developed as 

appropriate. 

-surveys, 

-focus groups, and 

- product evaluations by users. 

The software quality needs and priorities 

of the organization, customer, and end 

user are traceable to the system 

requirements allocated to software and 

the software quality goals. 

-establishing targets for the number of 

post-delivery defects 

-performing predictive exercises as the 

product matures to assess the likelihood of 

meeting those goals.  

Act 1 The project's software 

quality plan is 

developed and 

maintained according to 

a documented 

procedure. 

The capability of the project's defined 

software process to satisfy the software 

quality goals is assessed and 

Techniques such as Quality Function 

Deployment and Taguchi's method for 

robust design can be used to relate the 
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documented. quality goals of a product to the process 

capability.  

The software quality plan satisfies the 

quality plans of the organization, as 

appropriate. 

 

The software quality plan is based on 

plans for previous or current projects in 

the organization, as appropriate. 

 

The software quality plan is updated at 

the start of the project, at major project 

milestones, and whenever the allocated 

requirements change significantly.  

 

The software quality plan undergoes 

peer review. 
 

The software quality plan is reviewed by 

affected groups and individuals. 

-the customer, 

-the end user, 

-software engineering (including all 

subgroups, such as software design),  

-software estimating,  

-system engineering,  

-system test,  

-software quality assurance,  

-software configuration management,  

-contract management, and  

- documentation support.  

Senior management reviews the 

software quality plans. 
 

The software quality plan is managed 

and controlled. 

"Managed and controlled" implies that the 

version of the work product in use at a 

given time (past or present) is known (i.e., 

version control), and changes are 

incorporated in a controlled manner (i.e., 

change control).   

The points in the process where 

software quality is measured. 

 

The high-leverage quality goals for the 

software products.  
High-leverage quality goals for the 

software products are those that provide 

the greatest customer satisfaction at the 

least cost, or the "must haves" from the 

customer or end user.  

The actions that the software project will 

implement to improve on past quality 

performance. 

 

The activities to measure software 

product quality. 

-peer reviews,  

-prototype development,  

-product simulation 

-testing.  

Act 2 The project's software 

quality plan is the basis 

for the project's 

activities for software 

quality management. 

Quality goals for software work 

products, as appropriate. 
-the characteristics that are planned to be 

met 

- the critical characteristics that, if not met, 

would make the product undesirable or not 
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needed by the customers or end users.  

The actions that will be taken when the 

software product quality is projected not 

to meet the quality goals. 

 

Characteristics of product quality that 

describe how well the software product 

will perform or how well it can be 

developed and maintained are identified. 

-functionality,  

-reliability,  

-maintainability, and  

- usability.  

The measurements used to quantify the 

characteristics of software product 

quality are identified. 

-reviewing prior performance data and 

customer requirements, 

-developing prototypes, 

-expressing intermediate software 

products in formal representations,  

-using formal software engineering 

methods 

-conducting tests. 

For each characteristic of software 

product quality, measurable, numeric 

values, based on the required and 

desired values, are selected as quality 

goals for the product.  

-the mean time between failure as 

specified in the requirements,  

-the mean time between failure that must 

be achieved (as determined by analysis 

and experimentation), and  

- the mean time between failure that is 

planned to be achieved.  

Quality goals for the software products 

are documented in the project's software 

quality plan. 

-the characteristics that are planned to be 

met 

-the critical characteristics that, if not met, 

would make the product undesirable or not 

needed by the customers or end users.  

-software requirements,  

-software design,  

-coding 

- software test.  

Quality goals for each software life-cycle 

stage are defined and documented. 

-product defects related to each software 

life-cycle stage will be reduced from the 

previous product release by some 

predetermined percentage 

-a predetermined percentage of predicted 

defects will be found by the end of the test 

cycle. 

Act3 The project's 

quantitative quality 

goals for the software 

products are defined, 

monitored, and revised 

throughout the software 

life cycle. 

Quality goals for the software products 

and software life-cycle stages are 

revised as understanding of the 

products and understanding of the 

organization's, customer's, and end 

users' needs evolve. 

 

Act 4 The quality of the 

project's software 

products is measured, 

analyzed, and compared 

to the products' 

The software tasks are planned and 

performed to address the project's 

software quality goals. At the beginning 

of a software task, the team performing 

the task:  

An example of a change is revising a peer 

review checklist to address defects that 

have been found to escape peer reviews.  
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� reviews the quality goals for the 
software product,  

� determines the quality goals 
applicable to the software task,  

� identifies its plans to achieve the 
software quality goals, and  

� reviews changes made to the 
process to meet the software 
quality goals.  

The quality of the software work 

products of each software life-cycle  

stage are measured.  

-peer reviews,  

-simulation, and  

-testing.  

The quality measurements are analyzed 

and compared to the software quality 

goals to determine whether the quality 

goals are satisfied. 

 

Appropriate actions, consistent with the 

software quality plan, are taken to bring 

the quality measures of the products in 

line with the software quality goals. 

 

quantitative quality 

goals on an event-

driven basis. 

When it is determined that the software 

quality goals conflict (that is, one goal 

cannot be achieved without 

compromising another goal), actions are 

taken to resolve the conflict.  
� The cost for achieving the software 

quality goals is analyzed.  
� Alternative software quality goals 

are considered in light of long-term 
business strategies as well as 
short-term priorities.  

� The customer and end users 
participate in quality tradeoff 
decisions, as appropriate.  

� The software work products and 
plans are revised, as appropriate, 
to reflect the results of the 
tradeoffs.  

 

Act 5 The software project's 

quantitative quality 

goals for the products 

are allocated 

appropriately to the 

subcontractors 

delivering software 

products to the project. 

 Refer Software Subcontract Management 

key process area.  

 

 

4.5 Measurement and analysis 

Measure# Measurement description Examples 

M 1 Measurements are made and used to determine the 

status of the software quality management activities. 
-the cost of poor quality  

-the costs for achieving the quality goals.  
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4.6 Verifying implementation 

Verif # Policy Indicators 

Verif 1 The activities for software quality management are 

reviewed with senior management on a periodic basis. 
 

Verif 2 The activities for software quality management are 

reviewed with the project manager on both a periodic and 

event-driven basis. 

 

Verif 3 The software quality assurance group reviews and/or 

audits the activities and work products for software 

quality management and reports the results. 

At a minimum, the reviews and/or audits verify:  

1. The preparation of the project's software 

quality plan.  

2. The process for establishing and tracking the 

software quality goals.  

 

5. Management 

5.1 Organization 

 

The QA function will be a separate entity and will maintain independence from the project management 

by possessing a direct reporting function to the senior management.  

 

This structure will protect the QA team’s independence and objectivity concerning the assurance of high-

quality, professional products and services. This team is responsible for the development of an QAP that 

will be used to identify the roles and responsibilities of the members involved in the project: stakeholders, 

project managers, developers  

 

 

5.2 Tasks & Responsibilities  

 

The role of the QA team is to assist the technical staff to continually improve the quality of their work 

products and services.   
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The QA team is responsible for establishing processes and procedures that accurately verify and validate 

the adherence of project to applicable standards, guidelines, and procedures.   

 

The QA team will be involved at the start of the project.  They will participate in the development of the 

Project Management Plan (PMP), also the Phase I Transition Plan to establish their function within the 

project and to provide input into the project’s schedule and work breakdown structure (WBS).  

 

To ensure that QA activities are identified and that time is allotted for QA activities.  Funding for the QA 

team members will be planned within the task hours and cost structure.    

The organizational responsibilities as they relate to QA are:   

 

Senior Management  

 
� Provides management support, supervision, and oversight for the QA function 
� Ensures the independence of the QA function 
� Makes available staff and other resources as needed to support QA 
� Ensures resolution of problem and concern issues 
� Reviews QA audits and reports 
 

Project managers 

 
� Manages overall performance. 
� Ensures QA activities are conducted 
� Ensures compliance with the QA program 
� Ensures responses to deficiency reports from QA reviews and audits 
 

Quality Assurance Team  
  

� Develops and maintains the Quality Assurance Plan  
� Conducts audits and reviews 

 
o Ensures work products adhere to the appropriate standard 
o Develops audit and review procedures for project activities 
o Ensures the QA processes and procedures adequately control project quality 
o Ensures the QA activities accurately measure the product, service and process quality 
o Reviews and approves specified deliverables for release to customer 
o Promptly reports results of audits to the project task leader 
o Periodically reports unresolved noncompliant items to technical monitor/senior management 
o Maintains an on-going dialogue with the technical monitor and support staff   
o Ensures that the expectations of QA activities are identified and understood between  the  
o technical monitor, task leader, and the team members  
o Collects and analyzes metrics produced from the results of the QA process 
o Recommends changes in procedures to improve processes 

 

Technical Staff (Developers) 

 

• Implements task level quality control based on QA standards, policies, and procedures 

• Participates in reviews and audits 

• Performs corrective actions or process improvements in response to QA findings 

• Manages and controls defects/errors and corrections 

• Tracks the status of defects/errors until closed 
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The effectiveness of the QA team’s effort depends on the support and commitment of the technical staff 

and all levels of management.  All affected groups should be trained in the principles of quality assurance 

and be committed to the proper inclusion and performance of QA activities within their work efforts. 

 

6. Documentation 

 

All required documents for the project will follow the AUP standards concerning content and format. 

Standards will be identified and followed for all required project documentation. 

 

The activities are to be implemented according to customer requirements.  The required documentation is 

necessary to ensure that activities are planned, monitored and controlled and will be used to verify the 

adequacy of the actual processes and procedures used to develop and/or deliver products/services.  

 

The following templates will be used: 

 

Analyze and Design 

Template.AND315010.EN.Software Architecture Document 

Template.AND325001.EN.Data Model 

 

Business Modeling 

Template.BUS101001.EN.Target Organization Assessment 

Template.BUS101005.EN.Business Vision 

Template.BUS101010.EN.Business Glossary 

Template.BUS101015.EN.Business Rules 

Template.BUS105001.EN.Business Actor Specifications - Actor Name (ID) 

Template.BUS105005.EN.Business Use Case Specification - Use Case Name (ID) 

Template.BUS105010.EN.Business Use Case Model 

Template.BUS105045.EN.Business Architecture Document 

 

Configuration Management 

Template.SCM710005.EN.Impact Analysis - Change Request Name (ID) 

 

Deployment 

Template.DPL301005.EN.Deployment Model 

Template.DPL615005.EN.Release Notes - (Release) 

 

Environment 

Template.ENV20060521.EN.Base Template 

 

Implementation 

Template.IMP405001.EN.Integration Build Plan 

 

Project Management 

Template.PMS805005.EN.Risk List 

Template.PMS805010.EN.Business Case 

Template.PMS810010.EN.Product Acceptance Plan 

Template.PMS810025.EN.Software Development Plan 

Template.PMS810035.EN.Communication Plan 

Template.PMS810040.EN.Roles and Responsibility Matrix 

Template.PMS820001.EN.Iteration Assessment - (Iteration_Name) 



ANAIS SOFTWARE SERVICES    Version:  1.0 

Quality Assurance Plan   Date:  1/15/2007 

<document identifier> 

 

 

Confidential ANAIS Software Services, 2006 Page 13 of 21 

 

Template.PMS825005.EN.Status Assessment (<Project name>mmdd) 

Template.PMS825020.EN.Issue Notice 

Template.PMS838.EN.Communication Minutes (<Project name>.mm.dd) 

 

Requirements 

Template.REQ201001.EN.Glossary 

Template.REQ201005.EN.Requirements Management Plan 

Template.REQ201020.EN.Use Case Specifications - Use Case Name(ID) 

Template.REQ201025.EN.Vision 

Template.REQ201030.EN.Supplementary Specification 

Template.REQ201035.EN.Use Case Model 

Template.REQ210001.EN.Software Requirements Specifications with Use Cases 

Template.REQ210001.EN.Software Requirements Specifications 

Template.REQ210005.EN.Use Case Storyboard - Use Case Name (ID) 

Template.REQ210010.EN.Boundary Class Specifications - Class Name (ID) 

Template.REQ215001.EN.Requirements Review Record (<Project name>.mm.dd) 

 

Test 

Template.TST501001.EN.Test Plan 

Template.TST505001.EN.Test Model - Iteration Name 

Template.TST505005.EN.Test Cases 

 

7. Standards and Guidelines 

 

The Anais Software Services  Document Library contains artifacts templates, and guidelines and policies 

of ANAIS SOFTWARE SERVICES Software Services.  

The folder ‘Artifacts Templates’ contains the official templates provided for use within any projects 

developed by ANAIS SOFTWARE SERVICES Software Services.  

The folder ‘Guidelines and Policies’ contains documentation regarding various constraints which must be 

considered, and guidelines and policies to follow throughout projects lifecycles in ANAIS SOFTWARE 

SERVICES Software Services. 

8. Metrics 

8.1 Defect density reports 

The defect density will be performed iteratively for each version of the project deployed. The 
computation will follow the JIRA bug reports/per version. 

Ex: <Project Name>  version <1.0>  

- Total number of bugs reported 

- Total number of open bugs 

- Total number of reopen bugs 

- Total number of closed bugs 

- Total number of bugs moved to another version 



ANAIS SOFTWARE SERVICES    Version:  1.0 

Quality Assurance Plan   Date:  1/15/2007 

<document identifier> 

 

 

Confidential ANAIS Software Services, 2006 Page 14 of 21 

 

8.2 Requirement Traceability matrix 

 

Form the quality assurance point of view, this matrix will help in tracing all the requirements that have been implemented, and the ones that where 

missed in implementation process 

 

Source Artifact Requirement 

Description 
UC Reference SRS Reference Test Case 

Reference 
Vision Reference Other 

References or 

Comments 

This column contains 

a backward reference 

to appropriate 

artifact(s) and the 

specific section from 

which this requirement 

was derived. 

This column contains 

either the exact 

requirement text from the 

source artifact or shall 

contain an abbreviated 

description of the 

requirement. When 

deciding whether to break 

a statement into 

individual requirements, 

the analyst should 

consider how the 

requirement would be 

tested.  If the requirement 

will be tested by a single 

test procedure, then the 

requirement probably 

does not need to be 

broken down further.  If 

the requirement will be 

tested by multiple test 

procedures, then the 

requirement should be 

broken down into multiple 

requirements. 

This column shall 

contain a forward 

reference to the Use 

Case Specifications, 

Use Case Model or 

Software 

Requirements 

Specifications and a 

requirement identifier 

within the document. 

All software 

requirements must be 

mapped to one or 

more section(s). 

This column shall 

contain a forward 

reference to the 

Supplementary 

Specifications or 

Software 

Requirements 

Specifications and a 

requirement identifier 

within the document. 

All software 

requirements must be 

mapped to one or 

more section(s). 

This column shall 

contain a forward 

reference to the Test 

Case Specification, 

Test Plan, or Unit Test 

Case and a 

requirement identifier 

within the document. 

All software 

requirements must be 

mapped to one or 

more section(s). 

This column shall 

contain a forward 

reference to the 

Vision, or Business 

Rules and a 

requirement identifier 

within the document. 

All software 

requirements must be 

mapped to one or 

more section(s). 

This column will 

provide references to 

other documents or 

free-form comments as 

necessary. 
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From a QA point of view, requirements must follow the indicators described below: 

Statement Quality Indicators 

� Imperatives 
� Continuances  
� Directives 
� Options 
� Weak Phrases 

Document Quality Indicators 

� Format, Structure, and Size 
� Readability 

8.3 Customer satisfaction. 

Satisfaction with the overall quality of the product and its specific dimensions is usually obtained through 
various methods of customer surveys. 

Customer satisfaction is often measured by customer survey data via the five-point scale: 

- Very satisfied 

- Satisfied 

- Neutral 

- Dissatisfied 

- Very dissatisfied. 

9. Review and Audit Plan 

 

Different methods and techniques will be utilized depending on the specific quality assurance activity.   

The techniques, tools, and procedures that will be used are as follows: 

 

• Walkthroughs - Formal or informal, structured walkthroughs are used for orientation, examining 
promising ideas, identifying defects or errors, and improving products at any stage in the process. 

• Reviews - An independent evaluation of an activity or process to assess compliance with the 
project plan; or to examine products or processes against quality factors through the use of 
checklists, interviews, and meetings. 

• Audits - An independent examination of a work product or process to determine compliance with 
specifications, standards, contractual agreements, or other preestablished criteria.   

• Evaluations - An evaluation activity that examines products/services to determine compliance to 

customer requirements. 

• Process Improvement - A process improvement program designed to reduce the error rate in a 
process.  

  
Quality Assurance will provide an independent review of the processes used at key check points.  These 

reviews will seek to identify risks early, and will simplify monitoring and managing problem areas 

throughout the project.  Due to the dynamic nature of activities and the need to provide quick response 

requests, the QA team and the technical monitor will identify the sign-off  points at key check points of an 

activity to ensure that expressed goals and requirements are met. 

9.1 Walkthrough Procedure  

 

Walkthroughs are beneficial for evaluating plans, documentation and other deliverables and serve to 

orient staff members to new technology products and services.  Walkthroughs will be conducted internally 
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and on an as-needed basis.  They will be used to: 

 

• Present plans, documentation, or other deliverables for review and approval. 

• Review material in the preparation stages. 

• Critique and report quality deficiencies of plans, processes, and procedures. 
 

Walkthroughs will be scheduled early enough to allow for revisions if problems are identified.  Records of 

these walkthroughs will be maintained, along with issues that were identified and resulting action to be 

taken.  Issues can be accepted “as is” or may require more work.  If further discussion on the issue is 

required, additional walkthroughs can be scheduled.   

9.2 Review Process  

 

Reviews are important to assess compliance with a project plan.  Specifically, the review process 

examines products/services from the context of quality factors. Quality factors are categories of 

product/service attributes.  Examples of quality factors include:   

 

• Correctness - The extent to which a product/service satisfies the customer requirements and 
the stated objectives. 

• Timeliness - The product/service is provided when needed to the customer. 

• Reliability -  The extent to which a product functions accurately or service is provided on a 

consistent basis. 

• Productivity - The amount of resources to correctly produce the product or deliver the service, 
including the relationship between the amount of time needed to accomplish work and the effort 
expended. 

9.2.1 Review Procedures 

 

The QA team will plan and conduct a review according to accepted practices and standards.  A typical 

review procedure includes: 

 
1. Identify reviews in the WBS and project schedule 

2. Verify correct review procedures are in place 

3. Document review results against quality factors 

3.1 Verify product/service traceability, if applicable 

3.2 Verify product/service against contractual requirements 

3.3 Verify product/service against standards and procedures 

4. Validate corrections by scheduling follow-up actions and reviews 

5. Verify that defects or errors are tracked to closure 

6. Document review results against product validation information 

7. Summarize review findings for other technical groups/organizations (e.g., network       
engineering) 

8. Enhance review procedures 

9.3 Audit Process  
 

The QA representatives are responsible for conducting product/service and process audits. The purpose 
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of audits is to identify deviations in process performance, identify noncompliance items that cannot be 

resolved at the technical support or project management level, to validate process 

improvement/corrective action achievements, and to provide relevant reports to all management levels. 

 

A product audit is an independent examination of work product(s) to assess compliance with 

specifications, standards, customer requirements, or other criteria.  Product audits are used to verify that 

the product was evaluated before it was delivered to the customer, that it was evaluated against 

applicable standards, procedures, or other requirements, that deviations are identified, documented, and 

tracked to closure and to verify corrections. (IEEE STD 610) 

 

A process audit is a systematic and independent examination, to determine whether quality activities and 

related results comply with planned arrangements. And whether these arrangements are implemented 

effectively and are suitable to achieve objectives. (ISO 2000) 

 

The QA team will perform the following activities when conducting an audit: 

 

• Define the scope and purpose of the audit within the audit plan.   

• Prepare audit procedures and checklists for the audit. 

• Examine evidence of implementation and controls. 

• Interview personnel to learn the status and functions of the processes and the status of the 
products. 

• Discuss findings with the technical staff and task leader. 

• Prepare and submit an audit report to technical monitor/senior management  

• Refer unresolved deviations to technical monitor/senior management for resolution. 

9.3.1 Audit Procedures  

 

A typical audit would include the following steps: 

 
1. Clearly understand and adhere to the audit scope 

2. Conduct preparation meetings in advance of the audit. (Define areas to be reviewed. Define 
review criteria.) 

3. Conduct an overview meeting in advance of the audit 

4. Understanding of organization, products, and processes. 

5. Conduct the planned meetings, interviews, samples, etc. 

6. Review the preliminary findings internally with the audit team. 

7. Verify and classify findings from the audit. 

8. Validate audit findings with the audit recipient. 

9. Prepare the audit report for the audit client. 

10. Provide recommendations on request only. 

11. Follow-up on corrective action/process improvement. 

12. Improve the audit process. 
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An audit is considered complete when: 
 

• Each element within the scope of the audit has been examined. 

• Findings have been presented to the audited organization. 

• Response to draft findings have been received and evaluated. 

• Final findings have been formally presented to the audited organization and initiating entity. 

• The audit report has been prepared and submitted to recipients designated in the audit plan. 

• Document audit findings and recommendations and report to Project Manager. 

• The recommendation report, if required by the plan, has been prepared and submitted to 
recipients designated in the audit plan. 

• All of the auditing organization's follow-up actions included in the scope of the audit have been 
performed. 

9.4 Process Improvement 

 

The QA team is responsible for process improvement.  Process improvement is successful when an 

effective process emerges or evolves that can be characterized as: practiced, documented, enforced, 

trained, measured, and improvable.   

 

A corrective action plan must be developed when a deficiency in the process is detected. Corrective 

action should prevent the problem from recurring.   

 

Successive steps for implementing a process improvement approach are: 

 
1. Detection of quality-related problems 

2. Identification of responsibility 

3. Evaluation of importance 

4. Investigation of possible causes 

5. Analysis of problem 

6. Preventive action 

7. Process controls 

8. Disposition of nonconforming items 

9. Permanent changes 

The QA team will analyze the results of their findings in relation to the results of documented processes 

used to produce products or services.  This comparison will be used to determine which process may 

need improvement and to determine the effectiveness of changes to the processes.   This comparison will 

also be used to identify best practices that should be continued or implemented at other sites.  
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10. Evaluation and Test 

9.1. Evaluation Process  

 

Evaluations examine the activities used to develop/deliver products and services, ultimately determining if 

the activity is fulfilling requirements.  

 

 The QA function establishes criteria for an evaluation, verifies the process has been performed, and 

collects the metrics to describe the actual results of those activities. 

 

The main activities and test strategies used to ensure the quality of the process and of the product will be 

outlined in the Test Plan  

 

9.2. Testing in Anais Software Services Software Services 

 

Anais Software Services Software Services is determined to invest in testing and quality assurance of its 

software products delivered therefore usually the testing will accounts for 10% to 40% percent of software 

development. Well-performed tests, initiated early in the software lifecycle, will significantly lower the cost 

of completing and maintaining the software. It will also greatly reduce the risks or liabilities associated 

with deploying poor quality software, such as poor user productivity, data entry and calculation errors, and 

unacceptable functional behavior. 

 

From Anais Software Services Software Services point of view, testing is the process (i.e. activities, 

workers, and materials) used to identify the correctness, completeness, and quality for a developed piece 

of software. In other words testing is "the process of questioning a product in order to evaluate it", where 

the "questions" are things the tester tries to do with the product, and the product answers with its behavior 

in reaction to the probing of the tester. 

 

The ways in which Anais Software Services Software Services will perform tests, is described in each 

project's Test Plan and will depend on several factors: 
1. Application domain 
2. Project's budget 
3. Risk tolerance defined for the project 
4. Project's team 

 

11. Tools, Techniques and Methodologies 

JIRA 

12. Configuration Management 

 

Template.SCM710005.EN.Impact Analysis - Change Request Name (ID) 

 

13. Quality Records 

The quality records will be traced in Status assessment and Iteration assessment documents 
The client will have to perform the Acceptance plan and to provide feedback. 

 
The following documents should be included in deliverables documents: 
a) Test plan; 
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b) Test design specifications; 
c) Test case specifications; 
d) Test procedure specifications; 
e) Test item transmittal reports; 
f) Test logs; 
g) Test incident reports; 
h) Test summary reports. 

 

14. Risk Management 

 
The Risk management will be performed by project managers according to ANAIS SOFTWARE 
SERVICES - Risk Management Guidelines 

 

The purpose of Template.PMS805005.EN.Risk List document is to sort all the risks identified, analyzed, 

and prioritized for the project developed. In addition, the document contains, for each risk identified, the 

appropriate management strategy. 

 

Not taking into consideration the risks, means that the quality of process and product  can be affected and 

all measures taken so far become useless. 

 

Also the risks must respect the reporting method proposed by Anais Software Services in order to ensure 

a good management and resolution. 

Example: 

RS-02-0005: Lack of clear specification mean overrun budget 
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15. Appendix A - Document Control 

15.1 A.1 Document Status 

 

Status:  Copyright: ©2007 ANAIS Software Services 

Owner:  Maria Juverdeanu E-mail:   

Prepared by: Maria Juverdeanu 

Created at: September 21, 2006  4:44 PM Project: <Project Name> 

Modified at: September 27, 2006 2:54 PM Modified by: Maria  

Category:  

Pages: 21 Revision: 66 Time: 810 

Change Control Procedures: 

Submit changes: 

1. Activate Track Changes by selecting Tools->Track Changes (CTRL+SHIFT+E) 
2. Perform changes on the document 
3. Before saving the document update the Revision History 
4. Change comments to PROGRESS or REVIEW 
5. Update automated fields by selecting Edit->Select All (CTRL+A) and pressing F9 
6. Update the version number at the beginning of the document (the same as in Revision History) 
7. Save the document into the project documentation workspace 
8. Notify interested parties for review and approval 

Review and approve changes: 

1. Activate Reviewing tool bar by selecting View->Toolbars->Reviewing (CTRL+SHIFT+E) 
2. Accept or Reject Changes 
3. Before saving the document update the Revision History 
4. Change comments to REVIEW or APPROVED 
5. Update automated fields by selecting Edit->Select All (CTRL+A) and pressing F9 
6. Update the version number at the beginning of the document (the same as in Revision History) 
7. Save the document into the project documentation workspace 
8. Notify interested parties about the review 

 

15.2 A.2 Document Version Control 

Revision History 

Date Version Description Author(s) 

9/26/2006 1.0 Creating the document Maria Juverdeanu 
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